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Solution to Microsoft Excel: A Self Assessment Exercise

The easiest way to start is to open up the assignment file in Word, and then copy and paste the data into an Excel spreadsheet. Alternatively, you could enter the data by hand.

1. Save your workbook under the name Self_Test_Data.xls 

2. Compute a new column of the differences between the O’Brian and S&P returns.

3. Save your workbook under the name Self_Test_Anyl.xls (Use the Save As option.)

4. Use the appropriate Excel functions to compute the average, maximum and minimum of all three columns of numbers

After these steps are completed, your spreadsheet ought to look something like this:
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5. Use Excel to create a time series plot of the O’Brian and S&P returns. 

Excel can make some great charts, but you need to play with it a little and learn how to make it do what you want. First, select the data you want to appear in the chart:
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Then, under the Insert tab, select the type of chart you want (in this case a Line Chart):
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We get a preview of what the chart will look like. So far it isn't very encouraging:
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The chart includes a line for "Year", which we don't want. The lines for O'Brian and the S&P are way down near the horizontal axis. 

To get rid of the "Year" line, click on "Select Data" in the Data group:
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This is a little tricky. We want to get rid of the "Year" line in the graph, but we want "Year" to appear on the horizontal axis in our chart. So we click on “Year”, and then the “Remove” button:
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Now click on “Edit” in the right-side window where it says “Horizontal (Category) Axis Labels”. 
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Clicking on the little box with the red arrow in it will let you select a range directly from the worksheet.
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Then click on the red arrow again:
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And click on “OK”.
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Click on “OK” again, and the chart is updated:
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Sometimes it's nice to have the chart in the same worksheet as the data, but I have found that it is easier to use the chart in other programs (e.g. Word, PowerPoint) if we save it in a separate worksheet. Right click on the chart and select “Move Chart”, then type in a name for it:
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Now the chart is in its “own” worksheet tab.
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The chart will come out looking something like the one on the left below. It is recommended that you learn how to manipulate the elements of your charts, such as was done to produce the "improved" version on the right.
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	Default Excel chart
	Improved "Juran" chart


 We dragged the corner of the chart to achieve a more “square” shape.
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We formatted the vertical axis so that the horizontal axis crosses at the minimum value using Layout — Axes — Primary Vertical Axis — More Primary Vertical Axis Options.

We also formatted the vertical axis so that the values are expressed in percentages with 0 decimal places:
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We used the Chart Title button in the Labels group (under the Layout tab) to put in a Centered Overlay Title. We used the Legend button under the same group to move the legend. We right-clicked on the various text elements (legend, axis titles) and re-sized the fonts.
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Once you get used to it, it’s easy to change the look of the chart by right-clicking on things. Here we changed the colors of the lines, thickened them, and added markers for the data points.
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After working through the Excel Chart Wizard, you can copy the chart and paste it into Word. There are several ways to do this, but these are the steps used here:

Click on the chart so that the “Chart Area” is selected:
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Copy the chart using CTR+C. Then, switching to Word, click on Home — Paste —Paste Special — Picture:
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6. Copy your data to another worksheet in your workbook.

7. Sort the copied data by increasing magnitude of the difference in returns.

8. Re-sort the data back into original order. 

To sort by the magnitude of the difference, you need to add a new column that gives the absolute value of the difference. The Excel function "ABS" will do that for you. Here's what it looks like after you've sorted by the difference:
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9. Use Excel to create a scatter plot of the O’Brian returns versus the S&P returns. 

The scatter plot chart is made using most of the same techniques as the line chart. 
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Here are two versions:
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10. Use the Histogram Tool (in the Data Analysis Toolpak) to create a frequency histogram of the O’Brian returns. 

Excel has many features that are useful for statistics. The default histogram feature is not one of them. To make a useful histogram requires bypassing most of the defaults and doing it yourself. 
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	Default Excel chart
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Here's how we made this histogram:

Set up a column with upper limits for the ranges into which you want to divide your data (these ranges are sometimes called "bins" or "buckets"). If you don't do this yourself, Excel will use some bizarre algorithm to come up with its own ranges, and they are usually confusing.
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Then, in the Data tab choose Data Analysis — Histogram. The input range is the set of data you want plotted. The bin range is the set of cells containing your pre-determined range boundaries. The output range is where you want the data for your histogram to appear (these data will not be the raw data, but rather a count of how many observations appear in each of your ranges).
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Here’s what the output looks like:
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If you checked the box that says “Chart Output”, you’ll also get a chart:
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Note that the "Bin" column isn't really a good set of labels for the horizontal axis in our histogram chart. These are the upper boundaries of the ranges, and Excel will place the labels in the center of the range on the horizontal axis of the chart. This is misleading to people reading the chart, so we make up our own labels as shown below in column G.
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Once again, we need to make a few changes to the format of the chart. Here, we right-clicked on the bars and decreased the gap between them to zero. 
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We also got rid of the legend; a legend isn't of any use in a chart when there is only one variable.
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	Default Excel chart
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11. Save your workbook.

12. Print your results and close your workbook. 

13. Which investment looks superior, O’Brian or the S&P Index?

The decision as to which is superior is somewhat subjective. On one level, the two investments don't seem that much different from each other (look at the first chart again). When the S&P has a good year, O'Brian usually has a good year; when the S&P has a bad year, O'Brian usually has a bad year. This "moving together" behavior can be quantified using a statistic called "correlation"; we will deal with correlation later in this course.

The O'Brian fund does have a higher average return than the S&P (note the average of 20.9% vs. 11.1%), which suggests that the investor who wants to maximize his or her expected return would prefer O'Brian to the S&P.

But O'Brian also seems a little riskier (the S&P had negative returns twice in 10 years; O'Brian had negative returns three times). 

One way to look at risk is to study the range of returns for each of the two investments. The range is calculated by subtracting the minimum from the maximum. For O'Brian the range is 51% - (-5%) = 56%; for the S&P the range is 27% - (-7%) = 34%. An investor who is interested in minimizing risk would prefer the S&P over the O'Brian. In this course we will use other measures of risk, primarily a statistic called the standard deviation.

Ultimately, this exercise illustrates both the potential usefulness of statistics as well as its limitations: In this example, the investor still needs to make a choice between higher returns and higher risk. Charts and statistical measures of risk and return can help us understand the differences between two possible courses of action, but they can't replace judgment.

� This solution is based on "Microsoft Excel: A Self-Assessment Exercise", by Professor Peter Kolesar, Columbia Business School. This solution was written by David Juran (5/08).
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Solution

		Year		S&P_Index		OBrian		Difference

		1985		0.26		0.43		-0.17

		1986		0.15		0.18		-0.03

		1987		0.02		-0.05		0.07

		1988		0.12		0.3		-0.18

		1989		0.27		0.24		0.03

		1990		-0.07		-0.03		-0.04

		1991		0.26		0.51		-0.25

		1992		0.05		0.26		-0.21

		1993		0.07		0.3		-0.23

		1994		-0.02		-0.05		0.03

		Average		0.111		0.209		-0.098

		Maximum		0.270		0.510		0.070

		Minimum		-0.070		-0.050		-0.250
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Raw Data

		Year		S&P_Index		OBrian

		1985		0.26		0.43

		1986		0.15		0.18

		1987		0.02		-0.05

		1988		0.12		0.3

		1989		0.27		0.24

		1990		-0.07		-0.03

		1991		0.26		0.51

		1992		0.05		0.26

		1993		0.07		0.3

		1994		-0.02		-0.05





Chart1

		1985		1985

		1986		1986

		1987		1987

		1988		1988

		1989		1989

		1990		1990

		1991		1991

		1992		1992

		1993		1993

		1994		1994



S&P_Index

OBrian

Year

Returns

O'Brian vs. S&P

0.26

0.43

0.15

0.18

0.02

-0.05

0.12

0.3

0.27

0.24

-0.07

-0.03

0.26

0.51

0.05

0.26

0.07

0.3

-0.02

-0.05



Chart2

		0.26

		0.15

		0.02

		0.12

		0.27

		-0.07

		0.26

		0.05

		0.07

		-0.02



OBrian

S&P

O'Brian

O'Brian vs. S&P

0.43

0.18

-0.05

0.3

0.24

-0.03

0.51

0.26

0.3

-0.05



Chart3

		-20% to -10%

		-10% to 0%

		0% to 10%

		10% to 20%

		20% to 30%

		30% to 40%

		40% to 50%

		50% to 60%

		60% to 70%



Returns

Frequency

Histogram: O'Brian

0

3

0

1

4

0

1

1

0



Histogram Data

		Raw Excel Output:						Output Ready to Make Chart

		Bin		Frequency

		-0.2		0				Bins		Labels		Frequency

		-0.1		0				-0.1		-20% to -10%		0

		0		3				0		-10% to 0%		3

		0.1		0				0.1		0% to 10%		0

		0.2		1				0.2		10% to 20%		1

		0.3		4				0.3		20% to 30%		4

		0.4		0				0.4		30% to 40%		0

		0.5		1				0.5		40% to 50%		1

		0.6		1				0.6		50% to 60%		1

		0.7		0				0.7		60% to 70%		0

		More		0





Sorted

		Year		S&P_Index		OBrian		Difference

		1986		0.15		0.18		-0.03		0.03

		1994		-0.02		-0.05		0.03		0.03

		1989		0.27		0.24		0.03		0.03

		1990		-0.07		-0.03		-0.04		0.04

		1987		0.02		-0.05		0.07		0.07

		1985		0.26		0.43		-0.17		0.17

		1988		0.12		0.3		-0.18		0.18

		1992		0.05		0.26		-0.21		0.21

		1993		0.07		0.3		-0.23		0.23

		1991		0.26		0.51		-0.25		0.25

		Average		0.111		0.209		-0.098

		Maximum		0.270		0.510		0.070

		Minimum		-0.070		-0.050		-0.250



=ABS(D2)



Excel Histogram Data

		






